LENESANS Release Note

RZ/T2M Group
Encoder I/F HIPERFACE DSL Safety sample program

Summary

This document describes the RZ/T2M Encoder I/F HIPERFACE DSL® Safety sample program package. To
use this sample program, please obtain the “RZ/T2M Group Encoder I/F Configuration Library” release
package (Rev.4.00 or later).

Functionality Checked Device
RSK+RZT2M Board (RTK9RZT2MOC00000BE)
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RZ/T2M Group Encoder I/F HIPERFACE DSL Safety sample program

1. Package Contents
This package contains the following contents.

The Configuration Data included in this package supports up to 2 axes, but the sample program supports
only 1 axis; to use it with 2 axes, modify the sample program to support 2 axes.

1.1 Software
e Source Code

No. Name Version number

1 RZ/T2M HIPERFACE DSL Safety sample program 4.0

e Configuration Data

No. Name Version number
1 RZ/T2M Encoder I/F Configuration Data (HIPERFACE DSL) 1.2
2 RZ/T2M Encoder I/F PINMUX Data 1.0

1.2 Document

No. Document name Version File name

1 RZ/T2M Group Encoder I/F 4.00 (j) r11an0689jj0400-rzt2m.pdf
HIPERFACE DSL Safety sample (e) r11an0689ej0400-rzt2m.pdf (this document)
program Release Note

2 RZ/T2M Group HIPERFACE DSL 4.00 (j) r11an0688jj0400-rzt2m-hfdsl-safety.pdf
Safety Sample Program Application (e) r11an0688ej0400-rzt2m-hfdsl-safety.pdf
Note

3 RZ/T2M Group HIPERFACE DSL 1.30 (j) r01an6316jj0130-rzt2m-hfdsl.pdf
Interface (HFDSL) Application Note (e) r01an6316ej0130-rzt2m-hfdsl.pdf
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RZ/T2M Group Encoder I/F HIPERFACE DSL Safety sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
F— r11an0689jj0400-rzt2m.pdf
— r11an0689ej0400-rzt2m.pdf
L— workspace
— Software
| — iccarm
| | L— RZ_T2_hfdsl.zip : RZ/T2M HIPERFACE DSL Safety sample program set (IAR)
| —gcc
| L— RZ_T2_hfdsl.zip : RZ/T2M HIPERFACE DSL Safety sample program set (e studio)
L— Documents
— r11an0688jj0400-rzt2m-hfdsl-safety.pdf
F— r11an0688ej0400-rzt2m-hfdsl-safety.pdf
— r01an6316jj0130-rzt2m-hfdsl.pdf
L— r01an6316ej0130-rzt2m-hfdsl.pdf

The file structure of the RZ_T2_hfdsl.zip is shown below.

Top folder
I configuration.xml : FSP Configuration Data
— ( Environment File Depending on Build Tool )
— lib
| L— ecl
| — Config_hfdsl_v1.2.dat : RZ/T2M HIPERFACE DSL Configuration Data
| L— RZT2_pinmux_v1.0.bin : RZ/T2M Encoder I/F Pin Configuration Data
L— src
— hal_entry.c : HIPERFACE DSL Safety sample program
— hfdsl_main.c : HIPERFACE DSL Safety sample program
— enc_dat.asm : Encoder I/F Linker setup file (only e? studio)
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— hfdsl
— iodefine_hfdsl.h : HFDSL register definition file
F— r_hfdsl_rzt2.c : HFDSL driver file
— r_hfdsl_rzt2_config.h : HFDSL driver file
F— r_hfdsl_rzt2_dat.h : HFDSL driver file
L— r_hfdsl_rzt2_if.h : HFDSL driver file
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RZ/T2M Group Encoder I/F HIPERFACE DSL Safety sample program

3. About HIPERFACE DSL Safety Sample Program

This section contains information necessary to use the complete set of HIPERFACE DSL Safety.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program, HFDSL driver, and configuration data is shown in following table.
This table does not include memory size used by Encoder I/F Configuration Library, Flexible Software
Package, or C language libraries of the compiler.

ltems Memory Size
EWARM e? studio
[kBytes] [kBytes]
HFDSL driver Code 4.0 3.2
Data (with initial value) 0.0 0.0
Data (without initial value) 0.2 0.2
Constant Data 0.1 0.1
HFDSL configuration data Constant Data 93.0 93.0
Sample program Code 3.2 3.6
Data (with initial value) 0.1 0.0
Data (without initial value) 0.4 0.4
Constant Data 1.5 1.5
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RZ/T2M Group Encoder I/F HIPERFACE DSL Safety sample program

3.2 Hardware Information
3.2.1 Device
RZ/T2M

3.2.2 Target Board
(1) Board Name

RSK+RZT2M (RTKO9RZT2MOCO0000BE)

(2) Setting of the Target Board
The target board configuration is as follows.
SW4-1: ON
SW4-2: OFF
SW4-3: ON
SW4-4: ON
SW4-5: OFF
SW6-1: OFF

(3) Used Pins of the Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as
follows.

Channel Port name Pin header Input/Output Description
(Function pin name)

HFDSLO dsl_in0 (ENCIFO) CN1 #1 Input Data input
dsl_out0 (ENCIF2) CN1#3 Output Data output
dsl_en0 (ENCIF3) CN1#4 Output Drive/receive control

HFDSL1 dsl_in1 (ENCIF5) CN1#7 Input Data input
dsl_out1 (ENCIF7) CN1#9 Output Data output
dsl_en1 (ENCIF8) CN1 #11 Output Drive/receive control
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RZ/T2M Group

Encoder I/F HIPERFACE DSL Safety sample program

3.3 Procedures on Development Environments

3.3.1 Preparation before Executing the Sample Program
This sample program communicates with a PC. The USB connection terminal on the target board is CN16.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmit/receive
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems

(1) Build Environment

IAR Embedded Workbench for Arm (EWARM) Version 9.60.3
RENESAS FSP Smart Configurator (FSP SC) 2025-12
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure of the Sample Programs

The build procedure for the sample program is as follows.

1 Copy the extracted source files to the desired location.
2 Copy the following files from "RZ/T2M Group Encoder I/F Configuration Library" under lib\ecl in the
same folder as the source files. (If the "lib\ecl" folder already exists, overwrite it.) *'

o lib\ecl\r_ecl rzt2 iar.a
e lib\ecl\r_ecl rzt2 if.h

Activate EWARM.

o o bh W

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ_T2_hfdsl.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *2

Note: 1. Please use Encoder I/F Configuration Library revision 4.00 or later.
2. The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of
the EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
command $RASC_EXE_PATHS$
argument --compiler IAR configuration.xml

Initial directory

$PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file,

rasc.exe.

If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

R11ANO0689EJ0400 Rev.4.00
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RZ/T2M Group Encoder I/F HIPERFACE DSL Safety sample program

You can also start the FSP Smart Configurator directly from the command prompt by specifying
the folder where it is installed.

7 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rz,
rz_cfg, rz_gen, script and .setting folders will be generated.
G C\1_PragWorikWork_C\Work_EWA_960_3_fsp4.0.0\RZT2M_HFDSL_Safety_release_chk - FSP Smart Canfigurator - (m] x
| File Window Run Help
| 4 [RZT2M_HFDSL_Safety_release_chk] FSP Configuration X milen “% FSP Vizualization =0
=y @ +
| Summary Generate Project Content ‘El ”
Project Summary RENESAS
Board: RSK+RZT2M (RAM executien without flash memory)
Device: ROADTGOTSM24GBG
Core: CR52. 0
FSPVersion: 4.0.0
Project Type: Flat
Location: C:/1_Prog/Work/Wark_C/Work_EWA_96....0/RZT2M_HFDSL_Safety_release_chk 5
Selected software components
Arm CMSIS Version 6 - Core v6.1.0+f5p.4.0.0 o8
RSK+RZT2M Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0 =
»] B84
Support
Sumnmary | BSP | Clocks | Pins | Interrupts| Event Links | Linker Sections| Stacks| Components > gl
[T] Properties [2] Problems M ¢ = 8 EConsole ~-r=0

No consoles to display at this time.

Branermies are nat auailanie

8 When project generation is complete, close the Smart Configurator.
9 Select [Rebuild All] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2_hfdsl.out is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].
(5) Execution Result of the Sample Program
Run the sample program and enter commands in the terminal software window. For commands, see

4.11.6 console commands in the RZ/T2M Group HIPERFACE DSL Safety Sample Program Application
Note.

¥ COM4 - Tera Term VT
74 F) AT (H)
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Encoder I/F HIPERFACE DSL Safety sample program

3.3.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2025-12
Toolchain version: GNU Arm Embedded 13.3.1.arm-13-24
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.60

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Copy the expanded source file to any location.

2 Copy the following files in the "RZ/T2M Group Encoder I/F Configuration Library" to lib\ecl in the same

folder as the source file. (If the lib\ecl folder already exists, overwrite it.) *!
e lib\ecl\r_ecl rzt2 gcc.a
e lib\ecl\r_ecl rzt2_if.h

3 After launching e? studio and moving to the workspace, click the [File] menu-> [Import] and select

Existing project to workspace and click [Next].

4 On the project import screen, select the folder where the sample program was expanded as the root

directory.
5 Select a project, check Copy Project to Workspace, and click [Finish].

6 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

Q RZT2M_HFDSL _Safety_release_chk - & studio = (] *
| File Edit Source Refactor Mavigate Search Project RenesasViews Run Renesas365 Window Help
| o % - & CREE <L PR Q, &\) Not Connected - [ | Fgoces

Project Explorer = 8 = 8 =8 =

=5 7 1

Qutline X
There is no active editor ‘-:%l
that provides an outline,

| ~ 2= RZ_T2_hfdsl [Debug]
> [l Includes

[T conrquraton ] |

= RZ_T2_htdsleltlin
X| RZ_T2_hfdsl.elflaunch
5 (7) Developer Assistance

Problems Console Properties Smart Browser Smart Manual 7 8 = 8

Oerrors, 11 warnings, 0 others
~
Description Resource Path Location Type

» & Warnings (11 items)

sf-g configuration.xml - RZ_T2_hfdsl

Note: 1. Please use Encoder I/F Configuration Library revision 4.00 or later.
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RZ/T2M Group Encoder I/F HIPERFACE DSL Safety sample program

7 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rz, rz_cfg, rz_gen, script, .settings folders are generated.

{8} RZT2M_HFDSL_Safety_releass_chk - RZ_T2_hidsl/configuration.xml - € studic

File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas365 Window Help

-4 witEr G

Q. &Y NotConnected | [
| ProjectExplorer % = O 4§l [RZ_TZ_hfdsl] FSP Configuration X

g Outline = g
=R L)
Summar o % e
Y Generate Praject Content

v 25 RZ_T2_hidsl

There is no active editor that
@) Includes

provides an outline,
3 sre Project Summary
= lib RENESAS
Board: RSK+RZT2M (RAM execution without flash memory)
| RZ_T2_hfdsl.elfjlink Device: RSA0TGOTEM24GBG
¥| RZ_T2_hfdsl.elflaunch Core: CR52_0
Developesisaianee Toolchain: GCC for Renesas RZ
| Toolchain Version: 13.3.1.arm-13-24
FSP Version: 400
Project Type: Flat
Location: C:/1_ProgiWork/Work_C/Work_E2S_RZ..SL_Safety_release_chk/RZ_T2_hfds| |

Selected software components

Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RSK+RZT2M Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0

)EHO

Summary | BSP | Clocks | Pins| Interrupts | Event Links | Linker Sections | Stacks | Compenents.

Problems X Console Properties Smart Browser Smart Manual B =
Oerrors, 11wamings, 0 others
Description Resource Path

% Warnings (11 items)

Location Type

8 Select [Project] menu -> [Build All].
The Debug\RZ_T2_hfdsl.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program
Run the sample program and enter commands in the terminal software window. For commands, see

4.11.6 console commands in the RZ/T2M Group HIPERFACE DSL Safety Sample Program Application
Note.

T COM4 - Tera Term VT

AT (H)

TrA L) EWE(D JVHO-I(0)  D1AEIW)
art
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RZ/T2M Group Encoder I/F HIPERFACE DSL Safety sample program

3.3.4 Precautions for Creating Flash Boot Projects

When users want to create flash boot project (xSPI0 x1 boot mode) by using EWARM, change the alignment
specification for the beginning of USER_DATA and USER_DATA block 2 (for .rodata) to a 32-byte boundary.
The configuration data for the encoder interface is specified to be aligned to a 32-byte boundary. The change
is to prevent misalignment between the data layout transferred to RAM and the data layout recognized by the
program, even if such data is contained within .rodata.

The procedure for making changes is as follows.

Open the script/fsp_xspi0_boot.icf file and change the alignment specification at the beginning of
USER_DATA and for USER_DATA block 2 (for .rodata) to a 32-byte boundary, as indicated by the bold red
text in the figure below.

In RAM execution projects (RAM execution without flash memory), data transfer from ROM to RAM does not
occur, so this setting is unnecessary.

/* Place the variables to be used in the user program (Programs other than SSBL). */

define block USER DATA RBLOCK with fixed order, alignment = 32
{ block USER DATA RBLOCKO with alignment = 8 { section .data init },
block USER DATA RBLOCKl with alignment = 8 { section  DLIB PERTHREAD init },
block USER DATA RBLOCK2 with alignment = 32 { section .rodata init },

block USER DATA RBLOCK3 with alignment = 8 { section .version init }};

/* Allocate an address to copy the variables used in user program (Programs other than SSBL) to RAM. */
define block USER DATA WBLOCK with fixed order, alignment = 32

{ block USER DATA WBLOCKO with alignment = 8 { section .data },

block USER DATA WBLOCKl with alignment = 8 { section  DLIB PERTHREAD },

block USER DATA WBLOCK2 with alignment = 32 { section .rodata },

block USER DATA WBLOCK3 with alignment = 8 { section .version }};

R11ANOBS9EJ0400 Rev.4.00 Page 10 of 11
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Revision History

Rev.

Date

Description

Summary

1.00

Oct.31.22

First Edition issued

1.10

May 31.23

Appended section 3.1.2 for memory size information.

Updated the release note version number.

1.20

Oct 6.23

6to9

Append notes for the Encoder I/F Configuration Library revision.

Updated the target board name.
Updated the release note version number.
Updated file structure. (Removed RZ/T2M Pin Configuration data

from zip file.)

Updated memory size information.

Updated description of the CPU board setting. (Description for the
SW4-2 is changed. SW6-1 setting is added.)

Updated build environment for FSP v1.3.0. Figures are replaced.

1.30

Dec 15.23

2,3

Updated source code, configuration data and documents
revisions, and updated document filenames.

Updated return value of R_HFDSL_GetVersion to “1.1”.
Corrected to alter toggle-bit of the secondary channel.

2.00

Jun 28.24

2,3

1,5
6t09

Updated revisions of the application note and the release note.
Updated sample program version to 2.0. (Supported FSP v2.0.0.)
Updated memory size information.

Updated description of the board name.

Updated build environment for FSP v2.0.0. Figures are replaced.

3.00

Nov 28.25

2,3

6t09

Update description of the trademarks.
Update revisions of the application note and the release note.
Update sample program version to 3.0. (Add short message

transmission command. Support FSP v3.0.0.)

Update configuration data version to 1.2. (Add measure for long
message transmission error.)

Update memory size information.

Update build environment for FSP v3.0.0. Figures are replaced.

4.00

Apr 03.26

2,3

6to9
10

Update revisions of the application note and the release note.
Update sample program version to 4.0. (Support FSP v4.0.0.)
Update memory size information.

Update build environment for FSP v4.0.0. Figures are replaced.

Add “3.3.4 Precautions for creating flash boot projects”.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

- HIPERFACE DSL is a registered trademark of SICK AG.

- IAR Embedded Workbench is a registered trademark of IAR Systems.

- J-Link is a trademark of SEGGER Microcontroller GmbH.

- Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.
All rights reserved.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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